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            Visual CADD 4.0.4 Update 
 
 
List of Bug Fixes & Features: 
 
Memory & Resource Leaks 
 
*Using TrueType fonts in a Visual CADD drawing resulted in a steady climb in 
the GDI resources in use by VCADD. 
 
*In creating a Reference Frame, a Windows region object was created but never 
deleted. The result was a steady climb in the GDI resources in use by VCADD.  
 
*Revised memory management for VCADD running under the newer Windows 
operating systems, with the following results: 
 

• Increased the available memory in VCADD using WinNT/2000/XP. 
• A memory leak under WinNT/2000/XP was plugged. 
• Compatibility with 3rd party apps was improved for WinNT/2000/XP (3rd 

party apps include Excel VBA scripts). See the last section of this 
document if you have problems running 3rd party apps. 

 
Files & Print 
 
*Multiple instances of the same VCD file can no longer be opened in Visual 
CADD by double clicking on the same filename in Windows Explorer multiple 
times. Now you get a message saying the drawing is already open. 
 
*Double click from the File Open dialog or the Recent Files list with a line tool as 
default would do a mousedown and place the first point of the line. Now it opens 
the drawing but allows the user to place the point. 
 
*Visual CADD now correctly opens drawing files with a filename/path over 128 
characters. 
 
*Under File>Drawing Property (WIP)>Summary Tab, text in the Notes dialog now 
wraps instead of scrolling off screen to the right. 
 
*Corrected a bug which would give a warning message and fail to open the 
printer setup dialog for printers with names longer than 31 characters. It would 
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affect clicking the Options button on the PrintSetup (PT) dialog, and clicking the 
Printer box, Page Size box, or Setup button on the Print (PR) dialog. 
 
*Attempting to print a drawing with a filename over 79 characters no longer 
causes Visual CADD to crash. 
 
*Added a feature to the File>Merge(FM) command. By default the merge is 
placed at the (0,0) point of the drawing being merged. To place it instead at the 
lower left corner of the rubberbanding bounding box, first press and release the 
TAB key.  
 
Edit 
 
*Added a feature to the Edit >Paste (CTRL+V) command. By default the paste is 
now placed at the lower left corner of the rubberbanding bounding box. To 
instead place it at the (0,0) point of the objects being pasted, first press and 
release the TAB key. 
 
*Entities pasted from the clipboard to another program, such as Word, now show 
the correct linewidth. 
 
Layers & Layer Properties 
 
*Fixed a bug where the layer list in several of the layer combo dropdown boxes 
was not correctly updating to show which layers had entities (the ‘*’ in front of the 
layer name).  
 
*Fixed a v4 bug: if you select one entity that has been created in Layer 
Properties mode and  turn Bylayer off and call the Change (CH) command, the 
properties created with LP show as *** in the dropdown combo boxes (Note: 
toggling over to Fast Properties always showed the correct values). 
 
Settings 
 
*Removed the limitation of 80 characters maximum in edit boxes on the Path tab 
in the Settings dialog. 
 
*When pressing the "Browse" button on the Path tab, the dialog would open with 
the folder tree pointing to My Computer. Now opens to the current path. If the 
path is not valid, then the closest valid parent folder tree is opened, but nothing is 
selected. This is the Windows default behavior. 
 
*With the Numeric tab Entry & Display dropdown set to Decimal Feet, and the 
Decimal Places set to 0.1, drawing a 1 meter line using a manual entry of 1M no 
longer results in a 12 meter (39.4 foot) line but is now the correct 1 meter line 
(3.3 feet or 39.4 inch). 
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*Fixed a problem where on some non-English versions of Windows, the System 
Information button on the Help About dialog was grayed out.  
 
Win2000/XP 
 
*In Win2000/XP, Visual CADD no longer retains focus nor “flashes” its taskbar 
button while another program is active. Also, with AutoHide on, taskbar now 
hides rather retaining focus and covering the bottom of other active programs 
(usually the status bar).  
 
Reference Frames 
 
*TrueType fonts used as text in dimensions now offset properly from the 
dimension line in Reference Frames. 
 
*Visual CADD no longer crashes when changing a filename for an existing 
Reference Frame with the “Document” setting current (as opposed to “File on 
Disk”). Note tha t "Document" has been changed to "File already Open" to more 
clearly reflect what is going on. 
 
*A Reference Frame using the Bind Data option no longer has a pathname limit 
of 32 characters. Previously a file exceeding this limit would not open. 
 
Symbols & Attributes 
 
*When a symbol is created with Symbol Create (YC) while the Symbol Manager 
is open, the Symbols Loaded list now updates with the new symbol (not 
applicable to Symbols on Disk view until the symbol has been saved to the hard 
drive with the Symbol Save command). 
 
*Also, If Symbol Create (YC) was used with Symbol Manager open, the symbol 
creation would sometimes fail. Symbol Create now works whenever Symbol 
Manager is open. 
  
*When a drawing with a Reference Frame in it was closed, an icon with no name 
was left in the symbol manager list when Symbols Loaded was the view. Fixed.   
 
*Symbol Manager list now displays correctly with any directory/folder that has a 
dot in the name. For example, previously "C:\ 4.0.3” displayed in the list as “4” -- 
the string would be truncated before the first dot. 
 
*Corrected a problem with a symbol created when “Use Layer Properties” is 
active. If the symbol was created with a bylayer color property that was the same 
as the display background color, the symbol was drawn with the background 
color and was thus not visible onscreen.  
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*A symbol containing an embedded Attribute that was originally created with the 
“Prompt Insert Point” setting is now placed correctly. Previously, it would not ask 
for the prompt, and the attribute instead would be displayed at an incorrect point 
some distance from the symbol. 
 
Object Info 
 
*With text, the handle point in OI was always given in inches, regardless of the 
current display units. Now displays the correct unit. 
 
*The Fill status for vector text  mirrored the same setting as Monospace. It now 
correctly shows the on/off state of Fill. 
 
*The height and width reported for Reference Frame size was always equal. Now 
shows the correct x-y dimensions. 
 
*Proximity Fixed setting is now shown correctly for Linear Dimensions. Previously 
it displayed the inverse of the actual setting.  
 
Display 
 
*Using a scroll wheel mouse, images scrolled off-screen and then back on are 
now updated (previously required a manual Redraw [RD]). Note that you must 
move the mouse slightly after (or during) the scroll to update  the display. 
 
*The display (onscreen and/or printing) of certain entities (e.g., circles, elliptical 
arcs, ellipses) which would show straight line segments instead of smooth curves 
at some resolutions or scales (e.g., a circle may appear as a hexagon) has been 
fixed. 
 
 Modify 
 
*Editing or modifying text line(s) not on the current layer no longer moves text to 
the current layer (NOTE: this problem did not previously happen when "Use Text 
Layer" was checked).  
 
*Corrected a bug in the Join command where line endpoints less than 1 inch 
apart were interpreted as being identical points, leading to one reason for the 
"too many points..." error message. 
 
*Added selection ribalog for Join when command is called with zero or one object 
selected (because you need at least two objects to Join), and made the 
command repeatable with spacebar.  
 
*Eliminated zero-length segments which sometimes were created while using the 
Continuous Line, Irregular Polygon, Trim, Join and Close Contour commands.  
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* When selecting a common endpoint with the Move Point command where some 
of the points are on hidden layers, all entities were moved instead of just those 
on displayed layers. Now the objects on hidden layers are ignored. 
 
Scripts 
 
*LdrTextFont native command is fixed and works as follows in a script (for 
example): LdrTextFont;Arial; 
 
*Fixed a bug in the Assign Script dialog to preserve existing bitmaps and menu 
entries in Custom Commands that were originally created via the cmdext.def file. 
Previously, editing a Custom Command in AS would strip out bitmaps and menu 
entries.  
 
*Fixed focus/highlight problem in AS text edit box when inserting commands from 
the command list at right side of dialog. 
 
*Fixed a bug where it was possible to  type a script in the Script.def or Cmdext.def 
files longer than the 255 character maximum (as defined in Assign Script). After 
saving the file(s) and reopening VCADD, the program would crash. 
 
*Added a checkbox (checked by default) on the Assign Script dialog to toggle 
between full native names and keyboard shortcuts when adding natives from the 
command list. Use full native names if you share scripts with others, because if 
they customize a keyboard shortcut it may conflict with your shortcuts and cause 
the script to fail. 
 
*Changed limit on length of a script from 255 to 32000 characters. 
 
*Increased the vertical size of edit box in Assign Script to accommodate longer 
scripts. 
 
*Scripts now support nesting. For example: OR;1;MyCustom;OR;2; where 
MyCustom is a custom command. Also, MyCustom may itself have a nested 
custom command, ad infinitum.  Nesting is supported to any level. 
 
*You can now start multiple scripts at VCADD startup from the VCADD.INI file. 
As with other scripts, separate them with a semi-colon. Here is an example listing 
with a couple custom commands that start 3rd party add-ons (these command 
names would be found in the cmdext.def file): 
 
[Startup] 
Script=Wheeler;ImgRD; 
 
*Two new Native Commands added: SaveSet and RestoreSet. Use these to 
save current settings before a script is run and then restore them afterwards. Be 
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aware that some commands save settings internally, and thus using the new 
natives may result in behavior not intended. 
 
Here is an example of how it is supposed to work: 
OrthoOff;SaveSet;OrthoOn;LineSingle;@;@;RestoreSet; 
 
This sets Ortho OFF then saves the settings with it Off.  It then draws a 
line with Ortho ON and restores the settings, bringing back Ortho OFF.  All 
is well. 
 
Here is an example of how it goes wrong: 
OrthoOff;SaveSet;OrthoOn;DimMoveTxt;@;RestoreSet; 
 
This looks the same and should work the same in theory.  However, DimMoveTxt 
does its own VCSaveSettings after Ortho ON, so the RestoreSet restores Ortho 
ON, not the original Ortho OFF. 
 
There are maybe 20 problem tools. Here is a partial list:  
 
SymCount (Bill of Materials) 
exporting DXF, DWG, GCD, SHP 
importing DXF, DWG, GCD 
DimEdit, DimCh 
leader edit (no native, but from pop-up menu, ED, etc.) 
DimMoveTxt 
DimSlideTxt 
DimMoveLine 
DimMoveArc 
Divide 
Clear, File Close 
MultiLine 
Bearings Tools 
Text Edit 
Hatch Edit 
  
Interface  
 
*Added bitmap buttons for the commands All Layer Edit, Explode Continuous 
Line and Filter Active toggles. Add these commands to your toolbars and the 
bitmaps will appear. 
 
*Fixed a bug in some edit boxes where extraneous decimal accuracy would 
appear, for example, the real world line width edit box.  
  
*Added check marks on menu items for the toggled states of IsoMode, IsoLeft, 
IsoRight, and IsoTop. 
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Snaps 
 
*Fixed a bug where a running snap was not correctly recognized as a snap by 
some tools (DimLin, DimAng, and MovePt). For instance, in earlier versions, 
dimensioning a line and clicking a point at one end of the line with Endpoint 
running snap would pick the line instead of only the point.    
 
*Corrected a problem with Snap Parallel using Direct Distance Entry.  In 
previous versions, if the length of a line started with snap parallel was 
specified with direct entry the resulting line would have a random length. 
 
API 
 
*Removed obsolete calls VCDimPoint, VCGetPreserveAcadColorNums, 
VCSetPreserveAcadColorNums, VCSethMenu, VCGetMainHMenu, 
VCLoadVCDFromStream, VCSaveVCDToStream. Note: these were 
disconnected in code and thus never worked.  
 
 
AutoCAD Import/Export 
 
*Added “Symbol Conversion” radio button options to the DWG Import/Export 
Settings dialog: 
 
Scale Placement: Specifies that during AutoCAD import/export, when converting 
to a unit other than inches, the placement scale is scaled and the symbol 
definition remains unchanged (This is the default setting from previous versions). 
 
Scale Symbol: Specifies that during AutoCAD import/export, when converting to 
a unit other than inches, the symbol definition is scaled and the placement is left 
unchanged. 
 
*To set the correct color mapping for newer ACAD versions, open the DWG 
Import/Export dialog, make sure that “AutoCAD Windows” is the map used on 
both the Color Import and Export tabs, click OK, and do an Environment Save 
(EN) so that the setting will “stick” next time you open VCADD. 
 
*Most DWG & DXF files that would hang or crash earlier versions of VCADD4 on 
import will now open. If you continue to experience problems with a particular file, 
please zip it up and send it to files@tritools.com . Provide a description of what is 
happening and we will troubleshoot it. 
 
*Most VCD files that would hang or crash earlier versions of VCADD4 while 
exporting to DWG/DXF should now export properly. If you continue to experience 
problems with a particular file, please zip it up and send it to files@tritools.com . 
Provide a description of what is happening and we will troubleshoot it. 
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*Critical errors encountered when importing or exporting should now give a more 
graceful exit –with error messages-- rather then just shutting down Vcadd. 
Please describe the contents of these error messages when talking to TriTools 
support about DWG issues. 
 
*The import of all the basic entities properties has been rewritten. 
 
* The import of layers and bylayer properties has been rewritten. 
 
*General scaling of entities, such as arcs and attributes, has been improved. 
 
*The import of AutoCAD blocks contained in a DWG has been extensively 
rewritten to eliminate crashes. 
  
*The import and export of any named object: layers, symbols, linetypes etc. has 
been revised to deal with AutoCAD invalid name characters and Acad2000 
names exceeding 32 characters in length. 
 
*Hatches and fills inside of symbols were not importing in previous versions. 
Please note that hatch or fill entities that have certain entities in their boundaries 
such as spline curves are not currently working correctly. 
 
*Acad curved leaders were importing as text and curves with no arrows in 
previous versions of VCADD. 
 
*In previous versions of Visual CADD, if an XREF was part of a DWG import, and 
you chose the “Convert to VCD” option on the DWG Import/Export settings 
dialog, a VCD file of the XREF was created with no user prompt This opened the 
possibility where a file of the same name could be overwritten without giving the 
user any notice. Now, a dialog box will pop up asking if you want to save the 
XREF and giving you the option to rename it. Note that renaming it may break 
the link, so that the XREF shows up in the drawing as a blank Reference Frame. 
If that happens, select the frame and change the reference to the proper path.  
 
*In previous releases of version 4, if a DWG had one or more layouts (also called 
paper space), you were asked if you wanted to open them. Choosing Yes would 
open the layouts in a separate VCD file (Visual CADD does not support layouts 
in the same file as the main drawing). 
 
These “layout” files were created without prompting or input. This opened the 
possibility where a file of the same name could be overwritten without giving the 
user any notice. Now, a dialog box will pop up asking if you want to save the 
Layout as a VCD and giving you the option to rename it.   
 
*Note that AutoCAD versions 2000 and later add one blank layout space to a 
DWG by default. Earlier versions of VCADD 4 would open this layout as a 
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separate VCD, even if it contained no information. Now, if the layout is blank, it is 
discarded on import into VCADD. 
 
*Messages and indicators on the status bar have been improved to better show 
the progress of the DWG import. 
 
 
Generic CADD Import/Export 
  
*Dimension units (inch, metric etc.) and unit precision now map correctly on 
import from GCADD files into Visual CADD. 
  
*Fixed a problem where Vcadd was not correctly storing some of the dimension 
points from imported GCD files and was thus incorrectly recreating them again 
on export back to GCADD. It was most prevalent with angled dimensions.  
  
* Vcadd now correctly reads whether dimension text is centered or not on import 
and export of GCADD drawings. Previously some text placed off-center was 
always converted to center.  
  
*When exporting from VCADD to GCADD, the dimension color is now properly 
converted. Previously it would export the color that was current when the dim 
was created in Visual CADD. 
 
*Corrupted hatches no longer cause a crash when importing a GCD but are 
instead stripped out. 
 
*Hatches created in Visual CADD and exported to GCADD will no longer fail 
when reimported to VCADD when set to import as a true associative hatch. 
Previously only hatches with the “Convert to Symbol” setting  would import 
properly.  
 
*Visual CADD now correctly imports Generic CADD symbols (CMP files) created 
in GCADD database units other than inches. Previously the components were 
not being scaled correctly. 
 
3rd Party Applications and Memory Conflicts 
 
If you are not using any third party applications with Visual CADD, or are using 
them and experience no problems in operation, you don’t need to read any 
further. 
 
Please note: The switches described below only have an effect on VCADD when 
it is running under WinNT, Win2000 or WinXP. Using the Win95, 98 and ME 
operating systems, you should never encounter a problem. 
 
To allow 3rd party applications to access its memory, VCADD uses a large block 
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of shared memory. In some cases, that memory conflicts with memory already in 
use by the other application. Under these circumstances, the 3rd party 
application will not be able to load the VCADD DLLs, so it will not run. 
 
Prior to v4.0.4, when this happened, a rather generic error message similar to the 
following would appear: 
 
"Run-time error 48: File not found: VCMAIN32.DLL" 
 
In v4.0.4, VCADD displays a more detailed message, including a specific error 
code, as described below. The previous error message may also appear. 
 
Since Visual CADD has no control of the block of memory another application is 
using, the solution is to move the location of the Visual CADD memory. In 
VCADD 4.0.4, two VCADD.INI switches are introduced to control VCADD's 
shared memory at startup. These switches are not listed in the INI file by default, 
and do not need to be added unless you are experiencing the conflict described 
above.  
 
Here is a sample listing (the text in parentheses on the third line  would not be 
included): 
  
[VCDefaults] 
NTBase=6B6C 
NTSize=64   (in Megabytes. Pre 4.0.4, 32 MB was the size) 
 
Normally adding only the NTBase switch will solve the problem, but in some 
cases, if you are using multiple 3 rd party applications, one of them may fail to 
open.  For applications that worked prior to v4.0.4, setting the NTSize to a value 
less than 64, but greater than 32, may allow all applications to run. 
 
To add one or both of the switches, navigate to the Visual CADD Programs folder 
and open the VCADD.INI file in an ASCII text editor such as Notepad. 
 
The switch listings must be entered under the [VCDefaults] section of the INI file. 
 
NTBase 
This value controls the base address of VCADD's shared memory.   A valid 
entry consists of four hexadecimal characters specifying the upper word of 
the base address value.  In most cases, this value can derived from the error 
code message generated when the memory conflict is detected.  The first four 
characters after the hyphen are used as the entry. 
 
Example: 
The second line of the error message reads: "Error code 487 - 676c0000" 
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the correct VCADD.INI entry is: 
NTBase=676c 
 
NTSize 
This value controls the amount of shared memory used.  It is specified in 
megabytes and must be between 16 through 64. 
 
Example: 
To set the shared memory size to 32 megabytes use: 
NTSize=32 
 
After making changes save the INI file, reopen Visual CADD, and see if your app 
will also run. If not, experiment with the settings as outlined above. 
 
If you use the above switches to resolve a 3rd party application problem, please 
inform TriTools of the application that caused the problem and the switch values 
used (e-mail to support@tritools.com). We will maintain a database to help other 
users resolve any memory problems. 
 
 


